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Executive Summary

This document collates all necessary information required for commissioning and validating of
BLDC system in GMRT Antenna.

The First BLDC system was put in Antenna CO4 after a substantial period of testing and
evaluation at set-up and antenna by team which included internal members (GMRT-NCRA) and

industry experts in motion control (M/s Maccon GmBH).

This report presents the various tests carried out to prove the efficacy of the Brushless
System in terms of functionality in meeting the servo needs of the GMRT antenna and its aptness
in interfacing to the existing Servo Computer and Interlock system. It also tries to present the

RFI compliance of the system.
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1. Introduction

1.1 Motivation of work

The old GMRT servo system is based on DC Servomotors which have been in use for
over two decades. The increasing trouble of maintenance and the obsolescence of the system
have induced the need to change to a new drive system. The new system is based on Brushless

motors. Overview details of old servo system is given in [1]

Upgraded GMRT servo system replaces four brushed motors with brushless DC servo
motors of Kollmorgen make. New motors used weigh one fourth of old motors which helps ease
work of commissioning the motor on Azimuth and Elevation platform. These motors use
electronic commutation which overcomes disadvantage of periodic maintenance required for
brushed motor which uses carbon brush and commutator assembly.

Kollmorgen make brushless motors are controlled by digital drives of Kollmorgen make.
Drives used are compact and software controllable. It provides human interface which can be
used for configuring type of motor being used, commutation technique etc. Drive houses the
current loop of servo system and provides current required to drive the motor depending on load
requirement.

Speed loop of new servo system is governed by Programmable Multi Axis Controller
(PMAC). Controller has DSP processor on board and is capable of controlling 8 axes at a time.
GMRT servo system uses four axes to control four brushless motors. Backlash compensation
algorithm to overcome play introduced due to spur gear arrangement is also implemented in
PMAC. Controller also provides interactive graphical user interface. It can be configured using
GUI as per system requirement

The main advantage of this upgrade is that BLDC system does not require periodic

maintenance which was done in brushed motor system.



1.2 Structure of Report

The basic structure of the report consists mainly of four parts. First part gives overview of
complete step by step procedure followed in commissioning BLDC system.
Second part gives details about pre installation checks carried out in PMDC based antenna
system.
Part3 explains system installation procedure. It describes drives and controller assembly in RFI
shielded rack in detail. Followed by this it gives information about interfacing existing servo
station computer (Which houses position loop) and interlock system with new BLDC system.
Fourth part gives details about post installation check carried out in BLDC system antenna to
validate whether new system installed adhered to specifications and standards of GMRT servo

system



2. Installation procedure overview

Installation procedure is broadly divided in to three steps as mentioned below. Overview of these

steps is given in this section. Details are mentioned in subsequent sections of this document.

A. Pre Installation checks to be performed in PMDC(Permanent Magnet Direct Current)

brushed motor system

B. System Installation steps for BLDC system

C. Post Installation checks of BLDC system

A. Pre Installation:

1.

RFI test:
RFI test is done to check radio emission levels of existing system.
Motor run test:

Perform ‘RUN Test’ in Manual/Local mode for both Azimuth and Elevation axis
and measure current and speed as per format enclosed (Refer Table1)

Interlock test:

Check all the limit switches in both axes for functionality and safety as
per format enclosed (Refer Table2)

Locked Rotor Frequency (LRF) and Step response test in velocity loop:

Perform LRF and step response test in the PMDC system, analyze data and note
down the parameters (Refer Table3)

Step response test in position loop:

Perform step response test by giving position step from control room and note down
the parameters (Refer Table4)

Tracking test:

Perform tracking test as mentioned in section 3.5



B. System Installation

1.

2.

10.

11.

12.

13.

14.
15.

Prepare cables required for rack internal wiring as per section 4.2.1

Carry out Electronic Cabinet (EMC) assembly for BLDC system as per section 4.2.2

Remove old Tacho and Power cables going from Antenna base along concrete wall to
AZ & EL platform, PMDC brushed motors and Round shell connectors(RSC)

Mount new brushless motors on both Azimuth(2 nos) and Elevation(2 nos) platform

Lay new 100m long Motor Power(2 nos) and Resolver cables(2 nos) along the
concrete wall from BL motor’s to Antenna base

Route the new cables along the wall and clamp them. Ground the shield of new cables
laid for BL motors every 20 meters

Remove Azimuth and Elevation Amplifier racks from GI room. Control rack is to be
retained in its place as 86 system and SSI is housed in it

Remove 13.5 KVA old transformer (4 nos) from GI room and move them to Ray
Shed

Install new transformer (15KVA) behind GI room

Shift the wired and assembled Electronic Cabinet (EMC) in GI room. (After testing in
Laboratory(Jogshed))

Install 24V/15A linear DC regulated power supply in GI room along with existing
110V/24V supply

Installation of GI cable duct on GI room for entry of cables coming from Antenna top
into GI room for EMC

Solder/Crimp the EMC circular connector from M/S Intercontec to all the cables laid
at both the ends

Do modifications in Control rack as per section 4.3

Interface BLDC system with Control rack as per section 4.4



C. Post Installation:

1.

Motor run test:

Perform ‘RUN Test’ in Manual/Local mode for both Azimuth and Elevation axis
and measure current and speed as per format enclosed (Refer Table15)

Interlock test:

Check all the limit switches in both axes for functionality and safety as
per format enclosed (Refer Table16)

Locked Rotor Frequency (LRF) and Step response test in velocity loop:

Perform LRF and step response test for the BLDC system analyze data and note
down parameters in Table 17

Comparative results should be similar pre and post installation
Step response test for position loop:

Perform step response test by giving position step command from control room and
note down the parameters in Table18

Tracking test:
Perform antenna tracking test as mentioned in section 5.3
RFI test:

RFI test is done to check radio emission levels of new system.



3. Pre installation procedures
3.1 RFI test:

Scope of test:
RFI test is done to check radio emission levels from old antenna system. Results obtained
are kept as reference and compared with RFI test done for BLDC system post installation

Procedure:
Test is done by RFI/OFC group. For details please refer [4]



3.2

Motor run test

Scope of Test:
Motor run test involves checking Tacho and current values for different voltage inputs.

These readings can be compared with ‘motor run test’ readings done after BLDC system
has been installed.

Equipment’s used: Digital multi-meter

Procedure:
1. Antenna setup is as shown in Figurel
2. Put antenna in manual mode using switch on servo system console.
3. Assure that speed pot on console panel is pointing toward zero
4. Release brakes of axis you want to perform test (Azimuth or Elevation)
5. Connect DMM probes to I/P HI pins on monitor card
6. Rotate pot on console till DMM shows 1V
7. Note down tacho and current readings in Tablel by connecting DMM probes to Tacho-
HI and current points on monitor card
8. Note down current and speed shown by HHT in Tablel
Commands to check tacho and currents in HHT:
M, D
D (It will show currents for M1, M2, M3 and M4)
Press ‘/° key
(It will show speeds for M1, M2, M3 and M4)
9. Repeat steps for different I/P HI voltage
Control Raclz
console Dizplay O wE OO wEm O
HE Seomaien ||© e O||© e O
Display o \|/ S8C Bin P | P
Keypad /I’:I
D2 El-Amplifier-B Az Amplifier-B

O veE (OO VPHEL O
Tacho- Tacho-
O Tasho- O || O Taghe- O

Monitor e

card Z | O Current (|| (O Cwrent ()

SSI Bin

Figurel: Motor run test setup



Antenna: ...l Date: ................
Azimuth/Elevation
Tablel: Motor run test
I/P ANT | M1 M2 |[M1 M2 Ampl | Amp2 | HHT HHT | HHT | HHT
(Volts) | DIR | Tach | Tach | Cur. | Cur. A A Cur.1l |Cur.2 |Spdl | Spd2
\Y/ \Y mV | mV A A Rpm | Rpm
1v CwW
2 CwW
3 CwW
4 Cw
5 CwW
Max Cw
1 CCwW
2 CCwW
3 CCwW
4 CCw
5 CcCcw
Max CCW
NOTE:

For input voltage: 1V to 5V: Operate in manual mode
For maximum input voltage: Use HHT in Local mode
Hand Held Terminal commands used:

M,C

H,A (Hold command to Azimuth axis)
P,A,deg:min:sec (To give position command)




3.3 Interlock test

Scope of test:

Interlocks are used in antenna for its fail safe operation. Interlock test is done to check status of
limit switches (whether it is working or not) and position where limit hit occurs. Test is done
again after BLDC system has been installed to check if there is any damage after BLDC
installation.

Procedure:

1.

Figure2 shows limit recovery card mounted in control rack which shows limit hit
indication

2. Put antenna in manual mode using switch in servo system console

3. Release brakes of axis (Azimuth or Elevation) for which you want to perform Interlock
test.

4. Rotate antenna by adjusting manual input pot to full scale. Antenna will rotate and hit
pre-limit and stop the Antenna by applying brakes. This will be indicated by blinking red
led in limit recovery card

5. To move further to hit final limit you need to bypass pre limit. Pre limit switch can be
bypassed by keeping it continuously pressed on limit recovery card. To start antenna
rotation bypass pre limit switch and release brakes. Antenna will rotate further and hit
final limit. Limit hit will be indicated by red led blinking

6. Follow this procedure for all interlock limit switches and note down remarks in Table2.1
and Table 2.2
Note: Limit switch will also be indicated on status display

Linit Pecovwvery candl Control Raclk
[ ] [=or ] Sns,
| e | | TETOE | ?»e;:'e?u Status
console Drisplay.
[rioe ] [=7or |
| 11oE | |'—’70F | SsSC Bin

Tananit

RPecowery

SsSI Bin

ol

Figure2: Limit hit indication in Limit recovery card for Interlock test




Table2.1: Elevation interlock limit switch test

Sr No. Limit Remarks Position
1 15P OK/Not OK
2 15F OK/Not OK
3 110P OK/Not OK
4 110F OK/Not OK
5 STP OK/Not OK
6 90D OK/Not OK
7 IN1 OK/Not OK
8 IN2 OK/Not OK
9 REL1 OK/Not OK
10 REL2 OK/Not OK
11 MOVL1 OK/Not OK
12 MOVL2 OK/Not OK
13 AOVL-EL OK/Not OK

Table2.2: Azimuth interlock limit switch test

Sr No. Limit Remarks Position
1 + 270P OK/Not OK
2 +270F OK/Not OK
3 -270P OK/Not OK
4 -270F OK/Not OK
5 ZERO Deg OK/Not OK
6 CWRAP OK/Not OK
7 MOVL1 OK/Not OK
8 MOVL2 OK/Not OK
9 AOVL-AZ OK/Not OK




3.4 Locked rotor frequency test and step response test in velocity loop

Note: Details of this section are referred from [2]
LRF test for velocity loop
Scope of test:

LRF is the first anti-resonance frequency in the bode magnitude plot of the system, at which, the
load appears to resonate as if the motors were blocked. It is desired for a stable servo system that
the LRF must lay far beyond its operating bandwidth.

Following test is done to check at what frequency LRF appears.

Brushed motor (PMDC) system
Requirements:

1. Signal generator HP 8116 A

2. Hand held terminal (HHT).

3. Grounding cable for AlO card.

. Tool kit with jewel set screwdriver.

. Laptop with Lab view

. NI daqg card 6221

. USB cable (To connect NI daq card with laptop)

. Shielded cable with probes at one end and open wire terminals at other end (To
connect NI daqg card to the Tacho output).

9. BNC connector cable with other end having parallel channel arrangement

oo ~NO O~

Procedure:
Note: Figure3 below gives connection details of test setup for doing LRF experiment

1. Connect the USB-6221 cable to the input of NI daq card and laptop

2. Connect the BNC connector end of the parallel cable to the signal generator and one
probe end to the Counter torque card (CTQ card) Azimuth test output (ground - red).
Connect the open end of wire to the pin No 1 and 3 of analog input of NI dag card.

3. Connect open wire end of parallel shielded cable to pin #4 and #6 of analog input NI
daq card and probe end to the Tacho HI terminals (ground - black) of Azimuth amplifier
A and monitor card.

4. Switch off the rack power. Remove the FRC connector of the AlO card of SSC bin and
connect the FRC connector end of the grounding cable to this. Connect the other end of
the grounding cable to a suitable grounding point.

5. Connect the HHT to the D type connector (D2) of the SSC bin.

6. Switch the antenna to LOCAL mode.

7. Give a HOLD command to the antenna from the HHT as

11



H, A

8. Make the Labview settings as follows:
8.1. Open lab view > New Project->Add step—> Acquire Signal->Dagmx
acquire=>Analog input->Voltage. This will open Supported physical channel
window with Dev (USB 6221) data channels.
8.2. Selectai0—> the OK. This will open Configuration window. Select Terminal
configuration as RSE (Reversible single ended).

8.3. Recheck NI daq card connections using Connection diagram.

8.4. Select Step setup—> Select Channel settings—> Select Add channels or click
+-> Voltage >select ail > Click OK ->SelectTerminal configurationas RSE.
8.5. Press Record—> Select Select all to record both input and output and name the
log appropriately and press OK.Enable the signal generator.
8.6. Go to Data view—> Right click and select Add signals
—> Select all signals.

8.7. Record for appropriate duration. Then, select Exportto—>Excel sheet. This
will open MS excel sheet with the data values. Save the .xIs file accordingly.
8.8. This file can be later used to analyze the data.

Control Rack

NIUSE DAQ
Card
USB
13 4 6 Momnitor Card
Lap tOp Cable * T ’
Tacho HI
J HHT
Sine sweep Q
. ]
Signal !
generator _IBanana pin Probe
connector
CTQ card
Test O/P
Points
Figure3: Block diagram of LRF test setup
Table3: LRF test results
Parameters obtained from LRF test
| Actual Expected
1 Locked Rotor Frequency ‘ Fr 1Hz

12




Step response test for velocity loop
Scope of test:

Step response test is performed to understand transient behavior of velocity loop for step
command given

Requirements:

1. Signal generator HP 8116 A

2. Hand held terminal (HHT).

3. Grounding cable for AlO card.

4. Tool kit with jewel set screwdriver.

5. Laptop with Lab view

6. NI dag card 6221

7. USB cable (To connect NI daq card with laptop)

8. Shielded cable with probes at one end and open wire terminals at other end (To
connect NI daqg card to the Tacho output).

9. BNC connector cable with other end having parallel channel arrangement

Procedure:

Note: Figure4 below gives connection details of test setup for doing step response
experiment

1. Connect the USB-6221 cable to the input of NI daq card and laptop

2. Connect the banana pin end of the parallel cable to the power supply output and the
probe end to the Counter torque card (CTQ card) Azimuth test output (ground - red).
Connect the open end of wire to the pin No 1 and 3 of analog input of NI daq card.

3. Connect open wire end of parallel shielded cable to pin #4 and #6 of analog input NI
daq card and probe end to the Tacho HI terminals (ground - black) of Azimuth amplifier
A and monitor card.

4. Switch off the rack power. Remove the FRC connector of the AlO card of SSC bin and

connect the FRC connector end of the grounding cable to this. Connect the other end of
the grounding cable to a suitable grounding point.

5. Switch on the rack power. Switch on Spectron multi output power supply and set it to
0.2 V. Then switch it off.

6. Connect the HHT to the D type connector (D2) of the SSC bin.

7. Switch the antenna to LOCAL mode.

8. Give a HOLD command to the antenna from the HHT as H, A

13



9. Make the Labview settings as follows:

9.1. Open lab view > New Project - Add step > Acquire Signal - Dagmx
acquire = Analog input = Voltage. This will open Supported physical channel
window with Dev (USB 6221) data channels.

9.2. Select ai0 = the OK. This will open Configuration window. Select Terminal
configuration as RSE (Reversible single ended).

9.3. Recheck NI daq card connections using Connection diagram.

9.4. Select Step setup = Select Channel settings - Select Add channels or click
+ - Voltage - select ail > Click OK - Select Terminal configuration as RSE.

9.5. Press Record > Select Select all to record both input and output and name
the log appropriately and press OK. Switch on the Spectron multi output power

supply.
9.6. Go to Data view - Right click and select Add signals

—> Select all signals.
Record for appropriate duration. Then, select Export to > Excel sheet.
This will open MS excel sheet with the data values. Save the .xIs file
accordingly.
This file can be later used to analyze the data.

Control Rack

NIUSB DAGQ

Card
uUsB
Cable 1 3 4 6 MMonitor Card
Lapto - 3
aptop T
1 Tacho HI
HHT
Step voltage of 1V |:i<
D2
P =
ower H
Probe
supply Banana pin
connector

M CcTQ card
Test QP
Points

Figure4: Block diagram of step response test setup in velocity loop
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3.4 Step response test for position loop

Scope of test:

Test is done to understand transient characteristics of antenna system for different step input
signals

Procedure:

1. Testis done by giving 1 degree and 10 degree position step from control room.
2. Data file obtained from control room is used to plot step response in GNUPLOT.
3. Transient response parameters are calculated and tabulated as follows,

Table4: Step response test results

Parameters obtained from step response

Srno Description Abbreviation Actual Expected
1 Peak overshoot(%) Mp
2 Peak time Tp
3 Settling time Ts

15




3.5 Tracking test

Scope of test:

Test is done to check whether Antenna tracking before and after BLDC installation is same or
not.

Procedure:
1. Track command is given from control room for different tracking speeds,
Azimuth: 15 arcmin/min and 150 arcmin/min
Elevation: 5 arcmin/min and 15 arcmin/min
2. Date logged by control room is plotted using GNUPLOT.
3. Tracking error is plotted as error = target position — Actual position

16



4. System Installation

4.1 Brief description of system

GMRT antenna is rotated on two axes: Azimuth and Elevation. Two motors in anti-backlash
arrangement are used to drive each axis. At present Brushed motors are being used. As a part of
upgrade it is being replaced by Brushless Motors. The mechanical arrangement has no changes.
Also, the control system structure of three nested loops i.e. dual current loop within speed loop

with backlash compensation within position loop is also maintained.

The Brushless motors (BLDC) are ac synchronous motors of Kollmorgen make.
The drives (amplifiers) used to generate the motion of the motors are ServoStar712
(SS712).These are also of Kollmorgen make. The current or torque loop is implemented in the
amplifiers. The speed loop is implemented in Programmable Multi-Axis Backlash controller
(PMAC) from Delta Tau. The backlash compensation is also included in the program (PLC)
which configures the dual motor speed loop. The PMAC acts as a very sophisticated counter
torque card. The PMAC receives the position error from Servo computer and generates torque

command for SS712 which generates switching commands for rotation of motors.

The BLDC rack houses the PMAC and the set of SS712, choke and ballast
resistor for each motor. Hence we have a single rack for both azimuth and elevation. The rack is
specially designed to meet the RFI/EMI requirements of GMRT. The cables connecting the
BLDC motors are laid to meet the RFI/EMI requirements.

Following Figure5 shows how 3 nested loops are incorporated within new BLDC system.

Figure6 shows a block diagram of how BLDC system replaces Brushed PMDC system in

Antenna base.

17



Position Loop
S Speed Demand
From SSC
S
C

BLDC/

\

BLDC

o O

Speed Loop Current Loop
Velocity Feedback
A T
R
Y
y
SS712
PMAC
+
| BACK
?| LASH
COM
PENS
ATOR
4 88712
A
R
Velocity Feadback *

0sition Feedback

Figure5: Servo system block diagram with new BLDC system
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4.2 Assembly of BLDC rack in laboratory

In upgrade phase first Antenna to commission BLDC system was Antenna C04.

BLDC rack for this antenna was commissioned by M/s Maccon, GMBH at Germany.

For subsequent antennas BLDC system is assembled at GMRT, Khodad site.
Required electronics, cables, EMI/EMC compliant rack is procured and assembly is
done by our team at GMRT.

Process involved in assembly of BLDC system rack is as follows,

1. Preparing cables for internal wiring of EMC cabinet

2. Wiring and Cables for EMC Cabinet

Pto..

20



4.2.1: Cable assemblies for EMC Cabinet (Internal rack wiring)

Table5: Details of cable assemblies for EMC cabinet

Name of the
signal

Qty of
cables

Specifications
of Cable

Length (inches)

Refer section mentioned
for connection details

3 phase AC
power

connector on
rack rear plate
to line filter

1

5 core shielded
cable
Size: 2.5 sg.mm

25

Section 4.2.2 A

Motor power
+Brake

Motor
connector
(Cabinet rear
plate) to
Choke

Lapp cable:
4G2.5-2x1

35

Section 4.2.2 E

Motor power
+Brake

Choke to
Drive (SS712)

Lapp cable:
4G2.5-2x1

20

Section4.2.2 E

Motor
Resolver
Drive to
Resolver
connector
(Cabinet)

Lapp Cable:
4x2x0.25

97

Section 4.2.2 D

Load Encoder
- Azimuth
axis

PMAC ENC
connector to
Encoder
connector
(Cabinet)

Lapp Cable:
8x2x0.25

100

Not connected
(Encoder feedback is given
to PC104)

Load
Encoder-
Elevation axis
PMAC ENC
connector to
Encoder
connector
(Cabinet)-
Elevation

Lapp Cable:
8x2x0.25

100

Not connected
(Encoder feedback is given
to PC104)
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1 Ph Power- 1 2 colours: Red 43 -
Fan and Black
From Line
filter to 230V Size: 1.5 sg.mm
connector each
(Cabinet) (For
Fan)
DC Power 4 2 colours: Red 54 Section 4.2.2 B
Drive to and Black
24V supply Connector used:
connector on Size: 1.5 sg.mm BEGA127MR23000006000
rack rear plate each
DC link 4 3 colours: Red Azimuth
Drive to regen Blue & yellow 75 Section 4.2.2 C
resistor Elevation105

Size: 1.5 sg.mm

each

Total cables 47
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4.2.2

Wiring and cables for EMC Cabinet (By M/s Maccon)

Note: Details in this section are referred from [3]

Cabinet internal wiring

A. Power wiring

The mains supply connection via a switch / fuse combination (32A) is fed to
connector X0 of the Servostar. In order to reduce EMC radiation the cable should be

shielded

Table6: Power wiring connection details

Servostar input power Filter Connector on cabinet
connector (X0) backplane
BEGA127MR23000006000
L1 L1 2
L2 L2 1
L3 L3 5
N? N 4
PE PE PE
Shield Shield -
$700 1 475 -
D—jD[O
12 »
. Do f ] oo, X
= ; “1L3 E—
// ‘E’E 3 D=0 ‘% U .2
| “L2 N
/ ~ al R Fus .
Z —< —3 1

- K

 — |
| S— —

Figure7: Connectiorfetween S712 and fiIE

B. 24V auxillary supply

The 24V auxiliary (logic) supply connection from the 24V logic supply is fed to
connector X4 of the S712. There is an internal filter in the Servostar in order to
reduce EMC radiation. Refer Figure8 below for connection details.

Fan, Broke

S700

X448
4 +24V

+24V f + =)—0
Amplifier 4 1 +24V ==
+24v — L
— =D — ——= —
2 B =2
- A — =3
[— =30 — ~—-—¢
S ia

_J->_S1602—Ennble
Figure8: 24V supply to S712
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C. External brake resistor and DC bus link
In order to lower the regenerative loads to each Servostar the two drives belonging to
one axis (so either Elevation or Azimuth) should have a connected DC bus link. Each
individual drive has its own regeneration resistor (1500W with 330hm). Refer
Figure9 below for connection details

SERVOSTAR 700 X8 SERVOSTAR 700 X8
o _‘I) b _;)
RBe(0) | ,) — ' \‘ RBe(00) | ,} ! : : ‘l |
i L g | 2 BAR1S0OW i o8 gl |1 § BAR 1500W
)_ B :§33R )_ n IR
4 1 I ] | 4 I I | I
8 _,) = ! 8 _,} . : : ‘
y/__________________________\‘,/J L‘y!_ _________________________ ,')
DC LINK BETWEEN DC LINK BETWEEN
EL SERVOSTAR 700 AZ SERVOSTAR 700
SERVOSTAR 700 % |, SERVOSTAR 700 % |
o ) o A
J J
5 k' """"""""""""" ,’\\ 9 /R\‘ """""""""""""" b
+RBe (+D0) _,) ‘ .( : | #RBe (+D0) _,} ‘ ‘ [H. \
P i TR o é BAR 1500W PO o é BAR 1500
)~ BRE ) R BIRE
8 o : i 1 8 o — ik ‘
J \J L) / L) L)
$ommmmmmmmmmmm oo ¥ e et ¥

Figure9: Connection between S712 and external brake resistor
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D. Resolver + thermal protection

The wiring has to be carried out for each of the 4 channels. Refer Figure10 for connection

details
Table7: Resolver connection details
Servostar S712 AKM7 motor resolver Connector on cabinet
Connector X0 connection backplane
ADFA021FR01000151000
2 Thermal protection 1(brown) |2
6 Thermal protection 2(White) | 6
8 S1 Sine (grey) 8
4 S3 Sine (pink) 4
7 S2 Cosine (blue) 7
3 S4 Cosine (red) 3
9 R1 Reference (green) 9
5 R2 Reference (yellow) 5
Connector housing Shield Connector housing
700 SubD9 round 12-pin Resolver
- H — At
L T
?{ { B IIXXXXH e
= I i
,oTT |
. N
o{ }._C__{_'_: : : : :—I—i—( 1w S3
?I:[-{ I-—Ca : : : : (8 S1
J TT T
> 100pH 4R _(5 : : : : (5 e
9 9
T I (1 b
100uH 4R7 ll ||
—1E I Il
I N
- [ ]
[ N - T T Motor |
2 | | 2
—Es { { I I \5—_ H e thermal control
~ LB —ad min. 5VDC/5mA
, N
C [ N
& ) W]

Figure10: Connection between S712 and motor resolver
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E. Motor power and Brake
The wiring has to be carried out for each of four channels. Refer figurell for

connection details.

Table8: Motor power and brake connection details

Servostar S712

AKMY7 motor power

Connector on cabinet

Connector X9 connection backplane
BDFA108FR05000150000

4 Motor Phase U 1

5 Motor Phase V 4

6 Motor Phase W 3

3 Gnd 2

2 Brake + A

1 Brake - B

Connector housing Shield Connector housing

—

S700

XCND

il T I

Figurell: Connection between S712 and motor power connector
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F. Drive controller Interface
The interface between the drive Servostar S712 and the controller Turbo PMAC
needs the following signal
1. Emulated resolver signal (Feedback signal from the motor to the controller)
2. Torque command signal from controller to drive (+/- 10V)
3. Drive enable signal from controller to drive
4. Drive status signal from controller to drive
Refer Figurel2 below for details.

MAC2-BLC-2
ENCODER (X1 .. X4) SERVOSTAR 700
A oo EXT. CARD X5
. Co A+ (white) Lo C 5
1 4 1 1
9 ] A- (brown) K | C 4
P B+ (green) P
2 b ——C ¢
i B- (yellow) P
10 — ——C 7
1 1 1 1
a - £+ L e
» P Z- (pink) I C 3
1 1 1 1
12 i ; GND (blue) ' E ~
1 1 1 \
N &g o
W e ¥
D-SUB15M D-SUB 9F
SHIELD: HOUSING SHIELD: HOUSING
MAC2-BLC-2 SERVOSTAR 700
AMPLIFIER (AMP1 .. AMP4) CONNECTOR X3
BBttt it 5 MINI COMBICON
[ z ¢ N
1 P DAG. A (while) L C 10 ANt
9 : : DAC A- (brown) ! ; C 9 (A-IN1-)
14 2 } AGND (green) Lo ~  AGND
N B ~
¥4 P AE_COM (yellow) P
| I
4 i : AE_NO (grey) {: E C 1 (EN)
1 1 i 1 I
12 Lo i Cod (14 (BRB/RTO)
P P —( 15(BRB/RTO)
Bl s s i S +—( 16 (DGND)
D-SUB15M

SHIELD: HOUSING

y SERVOSTAR 700
AC Bt CONNECTOR X3
MINI COMBICON

ov

be C 2 (XGND)

24V POWER SUPPLY >—< 1 (+24V)
b 3(STO1EN)
( ©(STO2EN)

Figurel2: Drive-controller Interface



4.2.3. Detailed circuit diagram of BLDC system rack
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Figurel3: Detailed circuit diagram of BLDC system rack
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4.3 Modification in control rack

Modification is done in following cards to make Control rack (SSC and SSI bin) compatible with
new BLDC rack.

1.

Modification in AlO card:
AIO card is modified to take care of speed and current scaling. Figure1l4 shows
modification in card done.

Modification in Relay card:
Relay card is modified to eliminate unwanted spurious voltage which gets introduced as
input to speed loop. Figurel5 shows modification in card done.

Modification in azimuth and elevation counter torque card:

Counter torque card is modified to bypass circuitry which provides backlash
compensation. In new BLDC system backlash compensation is done by Turbo PMAC
controller. BLC algorithm is implemented as PLC software code.

Figurel6 and Figurel7 show modification in card done.

Modification in power card/Brake card:

Power card/Brake card houses circuitry for motors brake enable/disable supply voltage
and stow panel supply voltage. New BLDC motors require 24V DC supply for enabling
motors which is different from PMDC motors. To make brake enable supply voltage
circuitry compatible to new system, power card/brake card is modified. Figure18 shows
modification in card done.

Modification in control rack top

Three phase contactor for BLDC rack is incorporated in power supply panel in control
rack. Connectors for 3 phase supply in and 3phase supply out are incorporated on control
rack top. Stow panel mounted on old Elevation rack is mounted in control rack.
Connector for stow panel circuitry is also incorporated on control rack top.

Figure19.1 shows modified control rack top. Table 19.1 shows details of each connector
mentioned in Figurel19.1

Modification in SSI PAL logic

SSI bin has logic card which governs interlock logic for various signals. PAL 1C U30
(For Azimuth) and U5 (For Elevation) are programmed with various Boolean equations
for taking required logic decisions.

In these equations minor modification is done for RGSO signal. Section20 gives details
of changes done in equations.

29



il S Vi e
Q-L00-3-9:466 ~£yf| 3HLNID HIED x.o_.vw.W YHEVHE
‘ON 'QuQ| 8-
167157 2V 0 asy 7m 5
wd Nt 3y SNOISNIAID 1Y o 103roud|
& 70004 1S3 T0a8
O¥¥8 15-0/1 90 YNV

TI0T/6/6 JINY/ELS/8MS

0/6$=JU1IND Surjeas
% I9L=ONIE], ~ITILIB)S OAIDS
dutegy=A91

o] PIAOUISY YU ZLTT/01°6 TS Wi 008T=AQ] -:SHODEIGIPOIY

—

TOTFYNT

Lan

a7

PA) o/ T 9OTUNY

SRy o8

il

AIO card

ionin

Figurel4: Modificat

30



N W a u3ITD ,.:ﬂ. 3UARE2 HlWvacau ~
t a Sv noSVIsay c.h....‘.Oh« vHEY!

o O 10 oY VHEYH
» 8614 uva smgjlf
4 N 3BY SNOISNZIG 17y T ¥ S
.I.l..’l!—-/l{ T L33roua| V4Lt

00 ¥O4 1SS~ 0078
ST SRR A
C

uv08 Av13y

- L <oy -
W . ,_e_u <9

(92]

10 B

S K

R I T

o} ik,

v 2 <Tw
Gt
- Aoy <y
) ’

(ha)ey M3

Co1i7td 40 amd 2y I |
<1H (3137t = 2]

sy STy
P R i1 sty 9
¢

o . o st e A
{jeq 752 <TMI——ey— o | ! gy 9
(g 5 < f ) i Mt (i #azy B

| - fuin Ty b
,m | | = = i
i ._u o ey ooy
wid %
v 7
A . ,,\ 3
! 1 i
- <HEF—= ; !
& s J
e -
h <y OoNE e ;
: v : a
i S M- oy ““
* =40 e ¥
..wsis N 1Y <o N nyu : i

31

Figurel5: Modification in Relay boar



e e, T2 e S e . e e

oA

e N e ‘ {4 okl
w1
; .ﬁ%,,v PI/SPa=01/901 IH : ﬁ _\wlw«lJ_nw Kt
o & [ [\JQ Ast-

w—ﬁ”—%bﬂ@d

|

-\ T
9 oL

_ofu FUERL-1)

L1/SPA=¢/904 IH

3

—-

1107/6/6:0EQ 4
JNV/ALS/ENS-Ag umey 9=UA—mm.OhUN<.Unﬁ—. {
=BOL/Z/T 134G ' B0 _gy-swa

p all ﬂ|
WILSAS Onas L - 110308 = N =
—: 3iLIL

HLWLZY - 305001 ¥3

el

4

AETH)

21T

S1/SPa=11/904 01

©—

sy of a1

e HiowzZl fmu wd0L Y3LNAOY)

Figurel6: Modification in Counter torque card (Azimuth axis)

32



_

4oz uATI3- 308¥AL WAINNOD =

1102/6/6 dNV/Ers/ass

" P0D-ISS-OLDTE-DATY

. s pmen AN oY
ez o/p -i3LyQ | G/0BE/oSY TON ¥
ER-VRY 3

L1315AS ONI 35S 1uv9

L/d€a=67/€0d 01

g oL aud )
:.".Za_ (B
~d€a=0¢-€Nd IH

i
——
T
’ - [N X
®-—1. @ 5

g

T S
; €

AEY

5

Co s
{ Ve
| T BT
ﬁ . ﬁx

bt P 5

,,

he

8 =g ,:Fx“.

NOILGETTT = QU5 Fa®Jdol ¥ILNAGD f

Figurel7: Modification in counter torque card (Elevation)

33



@92 Jamod | 6D Iwgyg = :
v 9D . v
- wwE w 'U 7 - “
o oo M 2 Io_\d:% > . .
QN\ sL :ﬁfir\ gL / . ”
/9% e & mw\mh\% “
T/9 Z.L e p R ‘
g " & m (
—Z/8Z [ L] (
Ko_\ﬁm\\ 4 ol \ “
lf&nn ¢ - .
- - (
_|M¥ ‘wotTiabd !
J . = N
kA “xoTe g8gd “
{
]
00N q
9 . 9 .
1\e ]
Suamn 4
/555 : ‘
— 2 jo | - ]
333 :
molfs | ; i
-Rg - 1"
g

U Mo/ ‘woee ibgy 0

| z ‘ S _ 9

D S e T T

(e BEEST LS|

Figurel8: Modification in Brake card/Power Card

34



6.
Control rack top

OICOIOIC

HOOO
0]0010l0

Figure 19: Modification in control rack top
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Table9: Control rack top connector details

Connector Description of connector Connector existing earlier or new one

number incorporated

Cc1 37 pin connector for EL interlocks (amplifier) — | Existing
MS3102R-28-215

cc2 37 pin connector for EL interlocks — MS3102R-28-215 Existing

CC3 22 pin connector for STOW Limit switch — MS3102R- | Existing
28-113

CC3A 37 pin connector for EL Limit switch — MS3102R-28- | Existing
215

CC3B 4 pin connector for EL Stow motor —- MS3102R-22-225 | New

Cc4 14 pin connector for EL Encoder — MS3102R-22-195 Existing

CC5 14 pin connector for AZ Encoder — MS3102R-22-195 Existing

CC6 14 pin connector for Wind meter — MS3102R-22-195 Existing

Cccr 4 pin connector for 1¢ power supply — MS3102R-22-22P | Existing

CCr7a 4 pin connector for 3¢ power supply out to BLDC — | New
MS3102R-22-225

CC7b 4 pin connector for 3¢ power supply in from MCB to | New
BLDC — MS3102R-22-225

CC8 37 pin connector for AZ Limit switch — MS3102R-28- | Existing
215

CC9 37 pin connector for AZ interlocks — MS3102R-28-215 Existing

CC10 37 pin connector for AZ interlocks — MS3102R-28-215 Existing
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7. Modification in SSI PAL logic

Section20: Modification in SSI PAL logic

SSI U5 BLDC Logic IC modification
; PALASM Design Description
; US

; Declaration Segment ------------
TITLE EL stop and axis control logic

PATTERN 1

AUTHOR Shailendra K.Bagde

DATE 10/03/11

CHIP _U5bldc PAL16L8
; PIN Declarations ---------------

PIN 2 BRK_SENSE_EL COMBINATORIAL; INPUT

PIN 3 DRIVE_UP_EL COMBINATORIAL; INPUT
PIN 4 EL_STOP_MAN COMBINATORIAL; INPUT
PIN 5 EL_STOP_REM COMBINATORIAL; INPUT
PIN 6 EL_STOP_PRKNG COMBINATORIAL; INPUT
PIN 7 MAN COMBINATORIAL; INPUT
PIN 8 REM COMBINATORIAL; INPUT
PIN 9 AOVL_EL COMBINATORIAL,; INPUT
PIN 10 GND s INPUT

PIN 11 AXIS_ON_CMD_IP COMBINATORIAL; INPUT
PIN 12 CAGE_EL COMBINATORIAL; OUTPUT
PIN 14 RUN_EL_SSC COMBINATORIAL; OUTPUT
PIN 15 STOP_EL_LAMP COMBINATORIAL; OUTPUT
PIN 16 AXIS_ON_CMD_OP COMBINATORIAL; OUTPUT
PIN 17 BRK_REL_OP COMBINATORIAL; OUTPUT
PIN 18 CAGE_IOK_FAIL COMBINATORIAL; OUTPUT
PIN 19 RGSO_EL_IP COMBINATORIAL; OUTPUT

PIN 20 VCC - INPUT
; Boolean Equation Segment ------

EQUATIONS
CAGE_EL= (DRIVE_UP_EL + /BRK_SENSE_EL + /(BRK_SENSE_EL + (/BRK_REL_OP)) ) +
MAN * (EL_STOP_MAN + EL_STOP_PRKNG) + REM * (EL_STOP_REM + EL_STOP_PRKNG)
+ CAGE_IOK_FAIL * ( MAN + REM)

RGSO_EL_IP= (/BRK_REL_OP) * (MAN * /REM + REM * /MAN)
RUN_EL_SSC=DRIVE_UP_EL

STOP_EL_LAMP=/(MAN * EL_STOP_MAN ) + (REM * EL_STOP_REM ) + CAGE_IOK_FAIL
+ EL_STOP_PRKNG * (MAN + REM))

AXIS_ON_CMD_OP=AXIS_ON_CMD_IP + AOVL_EL

; Simulation Segment ------------

SIMULATION
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SS1 U30 - BLDC Logic IC modification
; PALASM Design Description
; Declaration Segment ------------

TITLE AZSTOP LOGIC

CHIP _U30 PAL16LS8

PIN Declarations ---------------

PIN 1

BRK1_SENSE COMBINATORIAL; INPUT
PIN 2 BRK2_SENSE COMBINATORIAL; INPUT
PIN 3 DRIVEl UP COMBINATORIAL; INPUT
PIN 4 DRIVE2_UP COMBINATORIAL; INPUT
PIN 5 AZ _STOP_MAN COMBINATORIAL; INPUT
PIN 6 AZ STOP_REM COMBINATORIAL; INPUT
PIN 7 MAN COMBINATORIAL; INPUT
PIN 8 REM COMBINATORIAL; INPUT
PIN 9 BRK_REL_OP COMBINATORIAL; INPUT
PIN 10 GND ; INPUT
PIN 11 CAGE_IOKFAIL_OP COMBINATORIAL; INPUT
PIN 12 AXIS_ON_CMD_OP COMBINATORIAL; OUTPUT
PIN 13 AZ_BRKD COMBINATORIAL; OUTPUT
PIN 14 RGSO_AZ IP COMBINATORIAL; OUTPUT
PIN 15 AZ BRKD_SSC COMBINATORIAL; OUTPUT
PIN 16 RUN_AZ COMBINATORIAL; OUTPUT
PIN 17 STOP_AZ LAMP COMBINATORIAL; OUTPUT
PIN 18 DRIVE_UP COMBINATORIAL; OUTPUT
PIN 19 CAGE_AZ COMBINATORIAL; OUTPUT
PIN 20 VCC ; INPUT
; Boolean Equation Segment ------
EQUATIONS

AZ_BRKD=/ (BRK1_SENSE + BRK2_SENSE)
AZ_BRKD_SSC = (BRK1_SENSE + BRK2_SENSE)

DRIVE_UP = DRIVE1_UP + DRIVE2_UP
RUN_AZ =/ (DRIVE1_UP + DRIVE2_UP)

CAGE_AZ =/RUN_AZ + /RGSO_AZ_IP + (/AZ_BRKD)
+ MAN * AZ_STOP_MAN + REM * AZ STOP_REM
+ CAGE_IOKFAIL_OP * (MAN + REM)
RGSO_AZ_IP = /BRK_REL_OP * (MAN */REM + REM * /MAN)

STOP_AZ_LAMP =/ ((MAN * AZ_STOP_MAN) + (REM * AZ_STOP_REM) +
(CAGE_IOKFAIL_OP *(MA

SIMULATION

N + REM)))
Simulation Segment ------------
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4.4 BLDC-SSI interface

4.4.1 Block diagram of BLDC-SSI interface

Figure shows block diagram of BLDC-SSI interface. Details of connectors shown in

Figure21 is given in section 4.4.2, table21

BLDC Rack back panel 55T hack panel
Dl
C3
D2 D2
/ @
10
CCl0

Figure21: Block diagram of BLDC-SSI interface
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4.4.2 Connector details at both the ends

Table10: Connector details on BLDC back panel and SSI back panel

SSI Back panel

BLDC Rack back panel

Wire

Signal

Amphenol Round Shell
connector

C3-Socket: MS3102 R 18-12
S

C3-Plug: MS3106 F 18-12 P

9 pin D type socket connector

D2

0.75sq.mm 4 core braided
copper wire

Azimuth brake signal

Amphenol Round Shell
connector

C1-Socket: MS3102 R 18-12
S

C1-Plug: MS3106 F 18-12 P

9 pin D type socket connector

D1

0.75sq.mm 4 core braided
copper wire

Elevation brake signal

37 pin D type IDC crimp
socket

D2

Amphenol Round Shell
connector

CC1-S: MS3102R 28-21S

0.75sg.mm 37 core braided
copper wire

SSI - BLDC Amplifier
interface for Elevation

37 pin D type IDC crimp
socket

D10

Amphenol Round Shell
connector

CC10-S: MS3102R 28-21S

0.75sg.mm 37 core braided
copper wire

SSI - BLDC Amplifier
interface for Azimuth
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4.4.3 BLDC rack and SSI bin interfacing (Brake signals interface connection details)

Figure22 shows connection schematic between BLCDC rack and control rack and

Table 11 gives details in tabular form

CONTROL RACEK

|
AZ 1 [
|
_ ! ssi
BLDC RACEK BLDC | Brake Card
Rear plate |
XOISS1 On Choke | 3
_ Red D2/6,7 | Black
Br+ B | ( 5 j NETTE - 373 T
Br- E 1
- i D2i1,2 , Red 5 J3511
551 | S8l 5 Ohms/10W
= | Back panel
BLDC MOTOR = |
5| BrRakECcOT az1 | g | R39 =220 Ohms/o.2500
|
/PBLDC motor |
powWer conn | J3115
|
rza : CONTROL RACK
1
BLDC RACK I S 51
ReaB:gl(;te : Brake Card
KOS5 On Choke 1
Blue D2/8,9 | White o3
Br+ B- X 5] j 136/2 I:J 31/20
Br B+ D2/4,5 !
—[ , Blue = 136/1]
552 o 1 551 5 OhmsM1 0w
= | Back panel
= D2
BLDC_:&:OTOP_ |
BERAKECOIL AZ 1 6 | RA0 =220 Ohms 0. 25vw
T q\BLDC motor : 12116
power Conn 1
I
Figure22: Brake signal interface connection details (Azimuth axis)
Tablell: Connections details in tabular form for Figure22
BLDC AZ BRAKE SENSE WIRING DETAILS
Control rack top D1 -Plug pin D1 Recptcle Socket BLDC 55712
551 C1 mount BLDC D TYPE 9PIN | BLDC RACK MOUNT To Choke
Sr.No Signal Color Mating Connector | Terminnation end Terminal for Sense|
1 A BR+ RED 1,2 1,2 X9/551-Br+
2 B Br- BLACK 6,7 6,7 X9/551-Br-
3 C BR+ BLUE 4.5 4,5 X9/552-Br+
4 D Br- WHITE 8,9 8,9 X9/552-Br-
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Figure23 shows connection schematic between BLCDC rack and control rack and

Table 12 gives details in tabular form

CONTROL RACK

I
EL1 I
I
! 551
BLDCRACK BLDC | Brake Card
Rear plate |
HAISS3 On Choke | c1
Brt+ B- Orange D116, 7 | Brown
| 5 j 1335 - < T B
Br- B+ }
D11,2 | Orange A J33M
553 i SSi 5 Ohms/MOW
5 | Back panel
2
BLDC MOTOR @ |
5| BRAKECOIL AZ1 | g | R37=220 Ohms/0.25W
I
¢BLDC motor
power conn | J311 i"l
|
|
I _ -
£l 2 | CONTROL RACK
|
! SSI
BLDC RACK BLDC | Brake Card
Rear plate |
NSS4 On Choke | c1
—— B- green D2/8,9 | yellow
| ( D } 13472 I:Jgu_l 2
T B D2/4,5 :
, green Cc J341
554 S ' ssi 5 Ohms/10W
= I Back panel
o
BLDCMOTOR |
E\ BRAKECOIL AZ1 | g | R38 =220 Ohms .25\
I
II ¢BLDC motor | 131/18
power conn |
|
Figure23: Brake signal interface connection details (Elevation axis)
Table12: Connections details in tabular form for figure23
BLDC EL BRAKE SENSE WIRING DETAILS
Control rack top D2 -5\Plug Socket D2-Recptcle Pin BLDC S5712
Ss1C3 mount BLDC D TYPE9PIN | BLDC RACK MOUNT To Choke
Sr.No Signal Color Mating Connector | Terminnation end Terminal for Sense|
1 A BR+ ORANGE 1,2 1,2 %9/553-Br+
2 B Br- BROWN 6,7 6,7 X9/553-Br-
3 c BR+ YELLOW 4,5 4,5 ¥9/554-Br+
4 D Br- GREEM 8.9 8,9 X9/554-Br-
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4.4.4 BLDC rack and SSI bin interfacing (Drive signals interface connection details)
Azimuth (D10-CC10 interfacing) Tablel3: BLDC-SSI interface Azimuth axis

0-10v to AMP AZError +{High) PMAC CH7D9/2
Amplifire A AZ Error -{Low) B PMCCH7/5

Violet 8

8 H V| Violet T0 Relay Amp H -
9 | ) |oriveup| Grey |  DriveUPA |  DriveUP 24V fromss J syl | oy |9
10 K CAGE | White (age-A K - White
1 L 15V+ | Black Amplifire A L Black 10
1 M 15V- | Brown Amplifire A M - Brown 1
B | N |RsOL| Red | AmplificA | RGSOL : | N syt | | Rd | DR
" P | RGSO2 | Orange Amplifire A RGSO2 p PMAC/AMP3/4 Orange 13
15 R H | Yellow 0-10Vto Amp R - PINK

§ S Brown

Green Amplifire 8

Violet 19

2 A 24V | Brown ) z -

"B [ o [ | ved | ovewrs | owewhatvions s | speh | | ey | &
U b | CAGE | Orange Cage-B b - White
5 3 15V+ | Yellow Amplifire 8 C Black i
26 d 15V- | Green Amplifire d - Brown 2
2 | e [Resol| Blue | Amplifies | RGSOL. e st | | Rd | B
B f | RGSO2 | Violet Amplifire B RGS02 f PMAC/AMPA/4 Orange U
9 g WV | Grey ACOK 3ph TOR 3ph TOR coil g - Grey
30 h  |ACOKEL| White From Contactor 3phTOR 3ph TOR coil h White
3 j  [AXISON| Black TOTOR 24V control rack TOR control TORcoil| | Black
3 k  |STOWING| Brown From IN cont k Brown
3 m RLSG | Red From REL cont m Red 25
£ p p
36 r r
37 s s

*Interfacing details formulated by Shri. SJB, servo



nid
0ld

Elevation (D2-CC1 Interfacing) Tablel4: BLDC-SSI interface Elevation axis

0-10v to AMP

EL Error #{High)

PMAC CH8 D9/2

Amplifire A

ELError -(Low)

PMAC CH8 D9/6

K CAGE | White Cage-A K White
L 15V+ | Black Amplifire A L Black 10
M 15V- | Brown Amplifire A M Brown 1
P | RGSO2 | Orange Amplifire A d P PMAC/AMP3/4 Orange ]
R HI Yellow 0-10Vto Amp R PINK
S L0 Green Amplifire B S Brown

White

b CAGE | Orange Cage-B b
c 15V+ | Yellow Amplifire B ¢ Black A
d 15V- | Green Amplifire d Brown 2
f RGSO2 | Violet Amplifire B RGSO2 f PMAC/AMP4/4 Orange A4
g Y Grey ACOK 3ph TOR 3ph TOR coil g Grey
h | ACOKEL | White |  From Contactor 3ph TOR 3ph TOR coil h White
j AXISON | Black TOTDR 24V j Black
k | STOWING | Brown From IN cont k Brown
m RLSG Red From REL cont m Red %5
p p
r r
s s

PMAC

*Interfacing details formulated by Shri. SJB, servo
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4.5 Modification in BLDC drive (Servostar S712)

We get information about maximum speed at which motor is rotating and maximum

current being drawn by motor from drive system. This information is given as an input to SSC
which uses this data for over speed and over current indication

Output voltage from drives corresponding to maximum speed and maximum current
value is different in BLDC system as compared to PMDC system. To scale down voltage level as
per requirement of SSC, scaling is done in drive (servostar S712) using GUI as shown in

Figure25.

Scaling factor values (in percentage) is obtained as follows,

1. SPEED SCALING:
For PMDC Drive:

Tacho constant: 17V = 1000rpm

For BLDC SS712 Drive:
Analog Output equivalent for speed : 10V = 1800rpm

At the Analog Card the resistance divider is shown:

Input signal from

drives 5712
E [|1I"l.-'1 ohm

Va

R” 330Kohm

E/ Gnd

ADC

Figure24: AlO card modifications (For input signal scaling)
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If PMDC Motor rotates at 2000rpm, voltage received at A/l O card is 34V
Then across the voltage divider,

Va= 34*[(330x10°%)/ (1x10° + 330x10°%) ]

11220000 / 1330000

8.4V

Thus for PMDC
8.4V=2000rpm

Therefore for 10V =? (How much rpm)
rpm = 2000 x 10/ 8.4 = 2380 rpm

For BLDC the maximum voltage is 10V, hence the resistor 1Mohm is removed and Va is 10V
for 1800rpm.This requires scaling at SS712 end. The scaling Factor (n1) is calculated as:

100% (10V) corresponds to 1800rpm then
nl= (100 x 1800) / 2380

nl= 75.63% ; scaling percentage

2. CURRENT SCALING:

For PMDC:
10A = 250A

For BLDC:
10Vv=13A

Scaling factor (n2) for current
n2 =100 x 13/250

n2 = 5% ;Scaling percentage
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Current and Tacho settings in Drive GUI

124 Untitled - DriveGUI

File Edit Communication Drive Tools Yiew Help

Ny = | & [T HelpFL) K2 ‘ @ O DI @ & B85 & © OPMODE |3 Analog Torque v

= B DRIVED

= A Setup wizard Analog Ilo
[ Basic Setup

% Units [ Mechanical

[ CaNJ Field Bus Settings Analog Inputs
[ Feedback
® Motar | 0: Analog In 1 = Yelocity of Current Cmd [(OPMODE Dependent] A
3! Current Laop Analog Input 1 Analog Input 2
1. welacity Loop Ofset [0 | [Autooifeet] [0 | miv [Auta-offset

B Position Laop

" Position Data Current scale Aﬂ o At

3t s B B
&% Electronic Gearing Welocity scale pmd 10 pmd 10
3; Encoder Emulation Filter msec Filter msec
.
;. Digital [/C Welocity command deadband D my
B, Mation Service
@ status (Errors [ Warnings) Analog Dutputs
] Manitor Analog Output 1 Analog Output 2
[ Homing Function |1 w_act vl Function |2 I_act vl

"o, Mation Tasks
B8 oscilloscope

%

D48 Dffset | -59.18 i

il EtherCAT

I

E Bode Plot D/& Offest |-
Terminal

Reardy 5712 (DRIVED) @ COM? (D oOnlne MoHWEN (@& OK. not homed UM

‘s Start T it D Chany

Figure25: Settings for Current and Speed scaling in DRIVEGUI software
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4.6 Cable duct wiring details

Cable duct is mounted on top of shielded room. All cables coming down from azimuth and

elevation platform are routed through cable duct before going to BLDC rack and control rack.

Purpose of cable duct is to keep cables sorted and provide require separation between cables.
Figure 26 shows picture of cable duct mounted on shielded room.

DSCN1559.JPG (1024 x 768)

Figure26: Image of cable duct mounted on shielded room
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Following list of cables are routed through cable duct.

. AZ Encoder

. AZ RH motor

. AZ LH motor

. Wind east

. EL UP motor

. EL DN motor

. AZ limit switch

. AZ RH resolver
. AZ LH resolver
. Wind west

. EL UP resolver
. EL DN resolver
. FPS limit switch
. FPS encoder

. paint switch

. El limit switchl
. El limit switch2
. Thermostat

O© N O OB~ WwWwDN -

el el el e o e =
© O ~NOoO U~ WNEREO

49



4.7 Power panel installation

In PMDC system four 13.5KVA transformers are used to power each drive controlling
brushed motors. In BLDC system four 13.5KVA transformers are replaced by one
15KVA transformers. Power panel consists of 3phase contactor which makes connection
between BLDC rack and 15KVA transformer. Contactor is governed by timer which will
provide 3phase supply to rack after stipulated time period defined by user.

Power panel also consists of single phase isolation transformer which is used to provide
power to control rack. Single phase supply is associated with timer and contactor
circuitry.

Step down transformer of primary 230Vac to secondary 55Vac is mounted onboard
which provides supply voltage to stow panel circuitry. Figure27 shows image of power
panel mounted and Figure28 gives circuit schematic details of single phase power and
Figure29 gives circuit schematic details of three phase power.
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Figure27: Power panel mounted in control rack
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CCF AMPHENOL
RsC

POWER PANEL (CTReDIT DTHGRAM)

TS6LATION
SFORME

To D
230y Requlaked
VAC  Powex

ST S L)
|

Bl Thc4p

Ho 24V lloy’
S0HZ P

N

il 55Y fox
!, oTow civeuik

WHN
Fmsk

TDR

. h

8] 16

TOR (o)) ¢ 230vAC

Figure28: Circuit schematic of power panel (Single phase)
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POWER FANEL (CTROIT DTAGRAM)

4 phase _fl____
Inpuf \/U LE

(3om
baavs formey Z 2

(M63102-£-22.229

TBU{/ g TBC L/?

R

i

3 phase

OulpLLE
"—Z*‘" h BLDC Rack
(Me3102-R-12-226)

o o ST ¢ 1 ¢ B

(LINE)  (NEUTRAL)

Figure29: Circuit schematic of power panel (Three phase)
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4.8 Grounding details for BLDC system

Figure30 shown below gives details of grounding details after commissioning of new
BLDC system

Y, ?ror)c’btd, UPS (snnetions
Sewvo
Filtev
well : it
g alY 7 3 =i
] 15 KVA - : 8 okl
1 hicall ) ¥ ] o [‘] .
@ < ; i
e' N\ > -
¢ gl BLDC 249 5.1
1fl¢ 4, 5KVA pyri (3 .
E 4
/;_e.a l [i 4I< M| hqnd 5 i
iLter Lwjé o " Foopand
ABR kol i M
CONTROL A
RACK. ¢
‘sg,r,,. gl so12 Drive H2 Lhy
Ry B E
PRI et e AL o it et UV W E
SHEILDED RDOM [NSIDE

SHEILPED RpoM  OUTSIDE [

4 !
1
/ |
|

<
{
\

Figure30: Grounding details of BLDC system

Note:
After the installation of PC based Servo computer in PC 104 there is a need to give the

servo control rack power backup in case of main power failure. There is a proposal for
installation of a 4.5 KVA UPS which will provide UPS power to both Servo control rack

and ABR rack.

*Circuit details of Figure30 referred from [5]
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4.9 Stow panel installation

Stow circuitry is used to keep the dish steady in parked position. It consists of two stow
pins driven by two %2 HP motors. When high winds are experienced (>40kmph) antenna
dish is brought at parking position (Elevation angle at 90 degrees). To keep antenna
firmly in this position it is locked by two stow pins. To drive two %2 hp motors controlling
stow pins, stow panel circuitry is commissioned in control rack. This panel was earlier
mounted in old Elevation drive rack. Stow panel circuitry is powered by a step down
transformer of 230V-55V associated with bridge rectifier circuit. Circuit schematic of
stow panel is shown in Figure31 on next page
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Figure31: Stow panel circuitry
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5. Post installation procedures

5.1 Motor run test

Scope of Test:
Motor run test involves checking Tacho and current values for different voltage inputs.

These readings are compared with ‘motor run test’ readings done before BLDC system is
installed.

Equipment’s used: Digital multi-meter

Procedure:
Antenna setup is as shown in Figure32

Put antenna in manual mode using switch on servo system console.
Assure that speed pot on console panel is pointing toward zero

Release brakes of axis you want to perform test (Azimuth or Elevation)
Connect DMM probes to I/P HI pins on monitor card

Rotate pot on console till DMM shows 1V

Note down tacho and current readings in Tablel by connecting DMM probes to Tacho-
HI and current points on monitor card

Note down current and speed shown by HHT in Tablel

Commands to check tacho and currents in HHT:

M, D

D (It will show currents for M1, M2, M3 and M4)

Press ‘/* key

(1t will show speeds for M1, M2, M3 and M4)

Repeat steps for different I/P HI voltage

Control Racls

Ansgle Angle
IDasplay Display
Servo
sy sten ]E?_tar;ls El-Amplifier- 4 e Arnplifier-A
console 1splay”
(o TPHLD (|| TPHD
HET Connector location: (3 Tache- (3| [Ty Tacho-
~ " SE2C bin back panel HI HI O
Trispla: | \I/ SSC Bin
Pay . ) Current () ) Current ()
Keypad ‘ /D
D2
El-fimplifier-B bz Brnplifier B

o pEL || TRPHLD (O

Tacho- Tache-
. » O Tacher O[O Tacker O
\l Monitor e
card = || & cvrrene || (O Current

Figure32: Motor run test setup
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Antenna: ...l Date: ................
Azimuth/Elevation
Tablel15: Motor run test
I/P ANT | M1 M2 |[M1 M2 Ampl | Amp2 | HHT HHT | HHT | HHT
(Volts) | DIR | Tach | Tach | Cur. | Cur. A A Cur.1l |Cur.2 |Spdl | Spd2
\Y/ \Y mV | mV A A Rpm | Rpm
1v CwW
2 CwW
3 CwW
4 Cw
5 CwW
Max Cw
1 CCwW
2 CCwW
3 CCwW
4 CCw
5 CcCcw
Max CCW
NOTE:

For input voltage: 1V to 5V: Operate in manual mode
For maximum input voltage: Use HHT in Local mode
Hand Held Terminal commands used:

M,C

H,A (Hold command to Azimuth axis)
P,A,deg:min:sec (To give position command)
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5.2 Interlock test

Scope of test:

Interlocks are used in antenna for its fail safe operation. Interlock test is done to check status of
limit switches (whether it is working or not) and position where limit hit occurs. Test is done
again after BLDC system has been installed to check if there is any damage after BLDC
installation.

Procedure:

1.

Figure2 shows limit recovery card mounted in control rack which shows limit hit
indication

2. Put antenna in manual mode using switch in servo system console

3. Release brakes of axis (Azimuth or Elevation) for which you want to perform Interlock
test.

4. Rotate antenna by adjusting manual input pot to full scale. Antenna will rotate and hit
pre-limit and stop the Antenna by applying brakes. This will be indicated by blinking red
led in limit recovery card

5. To move further to hit final limit you need to bypass pre limit. Pre limit switch can be
bypassed by keeping it continuously pressed on limit recovery card. To start antenna
rotation bypass pre limit switch and release brakes. Antenna will rotate further and hit
final limit. Limit hit will be indicated by red led blinking

6. Follow this procedure for all interlock limit switches and note down remarks in Table2.1
and Table 2.2
Note: Limit switch will also be indicated on status display

Linit Pecovwvery candl Control Raclk
[ ] [=or ] Sns,
| e | | TETOE | ?»e;:'e?u Status
console Drisplay.
[rioe ] [=7or |
| 11oE | | bt | SsSC Bin

Tananit

RPecowery

SsSI Bin

ol

Figure33: Limit hit indication in Limit recovery card for Interlock test
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Tablel16.1: Elevation interlock limit switch test

Sr No. Limit Remarks Position
1 15P OK/Not OK
2 15F OK/Not OK
3 110P OK/Not OK
4 110F OK/Not OK
5 STP OK/Not OK
6 90D OK/Not OK
7 IN1 OK/Not OK
8 IN2 OK/Not OK
9 REL1 OK/Not OK
10 REL2 OK/Not OK
11 MOVL1 OK/Not OK
12 MOVL2 OK/Not OK
13 AOVL-EL OK/Not OK

Tablel16.2: Azimuth interlock limit switch test

Sr No. Limit Remarks Position
1 + 270P OK/Not OK
2 +270F OK/Not OK
3 -270P OK/Not OK
4 -270F OK/Not OK
5 ZERO Deg OK/Not OK
6 CWRAP OK/Not OK
7 MOVL1 OK/Not OK
8 MOVL2 OK/Not OK
9 AOVL-AZ OK/Not OK
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5.3 Locked rotor frequency test and step response test in velocity loop

BLDC System
Equipments required:

1. Hand held terminal (HHT).

2. Grounding cable for AlO card.

3. Tool kit with jewel set screwdriver.

4. Laptop with Pmacplot32pro and Pwin32pro (+ power cable)

6. USB cable (To connect laptop with PMAC controller)
7. BNC connector cable with D type connector (To connect the signal generator output to PMAC
analog input)

Procedure:

1. Figure34 shows detailed block diagram used for doing LRF test in BLDC system. Put

antenna in Manual mode.

Apply brakes to both axes (Servostar displays P12 for both axes).

Connect the laptop/PC to the PMAC controller using USB cable.

Run Pwin32pro.

In Pwin32pro window, select Setup -> Force all windows to device number ->PMAC-

00 USB plug & play and click OK. This will setup the communication between the

laptop/PC and PMAC controller.

6. Go to Files -> Download files -> LRF_Az_EIl_Velocity.pmc -> OK. This will download
the plc file desired for this experiment (File available in CD contents).

7. In the Pwin32pro terminal window, type following commands to enable the azimuth axis
motors:

#100 #200

5j/

While, these commands for elevation axis motors:
#300 #400

6j/

8. Open Pmacplot32pro. In the Pmacplot32pro window, click “Detail Plot”.

9. Then click on “Items to Gather” to“Gather Period” = “Source 17> Click >>-> “M-
variable” = Enter the M-variable number for selected motor (M-variables are given at
the end of this document) - Click >>-> The address gets displayed - Click “OK”
—2>“Source2” = Click >>- Mark “M variable” > Enter input variable number >
Click>>->The address gets displayed = Click “OK”.

10. Then click on “Scaling and Processing”=> “Source A” = “Edit” > Make following

settings:

agrwn

1. Item name: Motor velocity”

ii. Unit: counts/sec

iii. Scale: 000326

iv. Differentiate: Once.

Then, Click “OK” = “Source B” = “Edit” > Again make the following settings:
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I Item name: Input
ii. Unit: counts

iii. Scale: 0.000555
Then click “OK”.

11. Click on “Items To Plot”-> “Edit” ->Make following settings:
I. Horizontal Axis: Time
ii. Left Vertical Axis: Motor Velocity
iii. Right Vertical Axis: Input
Then, click “OK”->click “OK”.
12. Now click “Define Gather Period”.
13. Switch o_ the SSC rack power. Remove the at ribbon cable (FRC) connector from the
analog input/output (AlO) card of station servo computer (SSC) bin and replace it with the
grounding FRC cable. Connect the other end of grounding FRC cable to a suitable grounding
point and switch on the SSC rack power again.
14. In the station servo computer (SSC) rack press AZON button for enabling azimuth axis
and ELON for enabling elevation axis. Servostar shows E12 on the display of both axes.
15. Go to Pwin32pro terminal window and enter following commands
pl106 = 0.1
pl05=7
p104 =290
p108 = 25000
p100 = 2 # for azimuth axis
OR
p100 = 3 # for elevation axis

16. In Pmacplot32pro window, click Begin Gathering and at the same time press the output
button of the signal generator.

17. In the Pwin32pro window, check for counts changing for 1st or 2nd motor in azimuth axis
and for 3rd or 4th motor in elevation axis.

18. After approximately 290 sec, press End Gathering.

Tablel7: LRF test results

Parameters obtained from LRF test

‘ Actual Expected

1 Locked Rotor Frequency | Fr 1Hz
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BLDC Rack

UsB
Cable
Laptop ]
MNote:
1. LRF PLC code is programmed in PMAC
PMAC

2. Data logging done in Laptop using PMACPlotpro
software connected to PMAC through USE cable

Figure34: Block diagram of LRF test setup for BLDC system
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Step response test for velocity loop

Procedure
. Figure35 below shows block diagram of setup used. Now put antenna in Manual mode.
. Apply brakes (Servostar displays P12).
. Switch on the multi output Spectron power supply, set it to 200 mV and switch it off again.
. Remove channel-7 connector from Turbo PMAC and co
. Run Pwin32pro.
6. Open Pmacplot32pro.
7. In the Pmacplot32pro window, click “Detail Plot”.
8. Then click on “Items to Gather” to “Gather Period” = “Source 17> Click >> - “M-
variable” > Enter the M-variable number for selected motor (M-variables are given at the end of
this document) - Click >> - The address gets displayed = Click “OK” = “Source2” - Click
>> - Mark “M variable” - Enter input variable number - Click >> - The address gets displa
yed = Click “OK”.
10. Then click on “Scaling and Processing” = “Source A” = “Edit” - Make following
settings:
1. Item name: Motor velocity”
ii. Unit: counts/sec
iii. Scale: 000326
iv. Differentiate: Once.
Then, Click “OK” - “Source B” = “Edit” - Again make the following settings:

O~ wWwdN PR

Iv. Item name: Input
V. Unit: counts

Vi. Scale: 0.000555
Then click “OK”.

11.Click on “Items To Plot” - “Edit” - Make following settings:
i. Horizontal Axis: Time
ii. Left Vertical Axis: Motor Velocity
iii. Right Vertical Axis: Input
Then, click “OK”-> click “OK”.
12. Now click “Define Gather Period”.
13. In the station servo computer (SSC) rack press AZON button for azimuth axis and ELON for
elevation axis.
14. Servostar will display P12 on the display of both axes.
15. In Pmacplot32pro window select “Begin Gathering”, then press the output button of the
Spectron multi output power supply.
16. In the Pwin32pro window check for counts changing for 1st or 2nd motor in azimuth axis
and for 3rd or 4th motor in elevation axis.
17. After 100 s, press “End Gathering”.
18. Select “Upload data”.
19. Click “Plot Data”.
20. Save the Plot as .ppl file (default data format for Pmacplot32pro) and text file. The text file
can be used for the plotting the data using Matlab.
PMAC variable values:

1. Azimuth axis BLDC motors
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1.1. Motor 1-M variable : m162
1.2. Motor 2-M variable : m262
2. Elevation axis BLDC motors

2.1. Motor 3 M-variable : m362
2.2. Motor 4 M-variable : m462
3. M-variable for Input voltage to velocity loop
3.1. Azimuth: m5063
3.2. Elevation: m5064

BLDC Rack

usB

1. ap tOp Cable -

Step voltage of 1%

T |Ch-7
2 lcnsC ]

—
Power —

supply Two pin connector

Figure35: Block diagram of step response test setup for BLDC system



5.4 Step response test for position loop

Scope of test:

Test is done to understand transient characteristics of antenna system for different step input
signals

Procedure:

1. Testis done by giving 1 degree and 10 degree position step from control room.
2. Data file obtained from control room is used to plot step response in GNUPLOT.
3. Transient response parameters are calculated and tabulated as follows,

Tablel8: Step response test results

Parameters obtained from step response

Srno Description Abbreviation Actual Expected
1 Peak overshoot(%) Mp
2 Peak time Tp
3 Settling time Ts
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5.5 Tracking test

Scope of test:

Test is done to check whether Antenna tracking before and after BLDC installation is same
or not.

Procedure:

1. Track command is given from control room for different tracking speeds,
Azimuth: 15 arcmin/min and 150 arcmin/min
Elevation: 5 arcmin/min and 15 arcmin/min

2. Date logged by control room is plotted using GNUPLOT.
3. Tracking error is plotted as error = target position — Actual position

5.4 RFI test:

Scope of test:

RFI test is done to check radio emission levels from old antenna system. Results obtained are
kept as reference and compared with RFI test done for BLDC system post installation

Procedure:
Test is done by RFI/OFC group. For details please refer to document [4]
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